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Message from the
Vice-President
The Ajax Photography Club is yet again at the end of another busy and
successful season.
Tuesday, June 28th, 2016 is the APC’s first End-of-Season Gala
with keynote speaker, Ethan Meleg. We are combining this evening
with our AGM and it all happens at St. Francis Center on Church Street
at 6:30pm.

June 28

APC End of Season
Gala with guest speaker
Ethan Meleg

July 8

APC Fun Social & photo
feedback night at
Debbies cafe.

July 1

Ajax Canada Day
celebration photo
assignment

Sept 27

APC Member Meeting
7pm in HMS Ajax room

Debbie’s Boutique Café has continued to host several Friday
social nights.
APC members have been enjoying numerous outings, participating in
photo clinics and several new and interesting workshops.
The 52 week challenge and year end print competition resulted in
many outstanding photos and GTCCC winners to boot.
The Sumac event planned for the end of October 2016 is almost sold
out and the executives have many more plans on the agenda.
Let’s hope that the next session is as exciting as the last few months.
Regards
Richard Cousineau C.E.T.
APC Vice-President

Photo by Sharon Janushewski
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APC Member Meeting: Tuesday, June 28, 2016
with Keynote Presenter Ethan Meleg
At 19, he received a hand-medown camera from his parents
and began to learn the basics of
nature photography. In between
watching birds and taking photos,
he completed a degree in
Environment and Resource Studies
at Trent University.

Ethan is a freelance
photographer from Ontario,
Canada. He specializes in
photos of outdoor recreation,
landscapes, ecosystems, birds
and wildlife. He is represented
by major stock agencies
and has been published
by National Geographic,
Canadian Geographic,
Forbes, Ontario Tourism,
Lonely Planet, Popular
Photography and many more.
Ethan is a popular keynote
speaker, workshop leader and
magazine columnist.
He also writes the humour
and bird photography
columns in every issue
of Outdoor Photography
Canada Magazine.
Growing up near worldfamous birding hotspot,
Point Pelee National Park,
Ethan often skipped school
to watch songbirds during
migration. By the time he was
a teenager, he had developed
an in-depth knowledge
of nature.
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Before becoming a professional
photographer, Ethan worked as a
nature guide and tourism specialist
in our national parks.
Ethan is 42 years old and lives
in the Georgian Bay area of
Ontario. His greatest passion in
life is exploring the natural world
through his camera, whether
on exciting trips or in his own
backyard.

Presentation Talk:
“Confessions of a Crazed
Photographer”
As an outdoor photographer,
Ethan Meleg has crawled through
mud, kayaked deep into swamps,
endured -30 degree temperatures
and hiked for miles in total
darkness (often with 40 pounds of
camera gear on his back) to capture
spectacular photos of nature. In
this presentation, Ethan shares his
insight into the inspiration, passion
and knowledge that drives great
nature photography. Illustrated by
his favourite photos and stories,
this light-hearted and humorous
presentation is sure to entertain
and inspire!
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“A Little Relief for G.A.S.”
by Angela McMullen
I’ll admit that I’ve got a mild case of G.A.S. (Gear Acquisition
Syndrome). I like whatever makes my journey as a photographer
easier; or as I’m wont to say on occasion: ‘anything that reduces
the P.I.T.A. (Pain In The A**) factor.’ Last acronym—I promise.
However, like many amateur photographers, I don’t have lots of
spare cash laying around to spend on gear—especially the really
cool and expensive stuff. So what do I do? I look for cheaper
alternatives. Here’s an example.
I shoot a lot of baseball in the summer. To capture those great
catches in the outfield, I need my fast glass—that is, my heavy
lenses. But it’s a challenge to drag these big boys, and all my
other equipment, in a knapsack—even one designed for photo
gear. Now there are suitcase-style photography bags with
wheels, but the better ones come with hefty price tags and I’d
rather put that $500 towards a new lens. So rather than hitting
the local camera store, I head to the Home Depot.
If you’ve never been to this do-it-yourself store (or any hardware
store for that matter) in search of photography gear you’ve got
to give it a try. There are cheaper alternatives for lighting, stands,
and accessories if you think creatively and are handy.
On the day I went in search of a rolling camera bag, I headed
straight for the tools department and there it was, my dream
camera bag. Or I should say, a rolling toolbox soon to become
my dream camera bag.
For $80 (plus taxes, Oh Canada eh?) I bought a Husky© toolbox
which looks like a large duffle bag on wheels. It’s heavily
reinforced, has lots of pockets inside and out, and the handle
extends just like those rolling suitcases. It carries a significant
amount of weight and I even stack things on top as I roll my way
to the next baseball game.
What modifications were required to transform this toolbox into
a camera bag? A few pieces of foam (egg-crate style works best)
to line the bottom of the bag. And for those who don’t keep their
lenses in their cases, get some bubble wrap to keep them snug
and safe as you roll along.
So, if you suffer from G.A.S. spend your dollars wisely. For
accessories and lighting, search the library, on-line forums,
and YouTube for tips and tutorials on cheaper alternatives to
photography-gear name brands. You’ll be able to afford that
f/2.8 lens a lot sooner.

Book of the Month
Understanding
Exposure
by Bryan Peterson
Understanding Exposure has taught
generations of photographers how
to shoot the images they want by
demystifying the complex concepts
of exposure in photography. In this
newly updated edition, veteran
photographer Bryan Peterson explains
the fundamentals of light, aperture, and
shutter speed and how they interact
with and influence one another. With an
emphasis on finding the right exposure
even in tricky situations, Understanding
Exposure shows you how to get (or
lose) sharpness and contrast in images,
freeze action, and take the best meter
readings, while also exploring filters,
flash, and light. With all new images,
as well as an expanded section on
flash, tips for using colored gels, and
advice on shooting star trails, this
revised edition will clarify exposure for
photographers of all levels…amazon.ca

– Ron
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Ron’s Blog
Sign up and join our fun and
informative classes & workshops!

Year in Review
It has been a busy year: great presenters, many
topics, classes, workshops, events, and outings. A
new revised and updated constitution and by-laws
document that took many hours over two years
to complete. Classes have expanded to not only
included Camera Basics, we have introduced Colour
Management from monitor to printing, and many
other creative topics. Workshops have expanded
“Off Camera Flash” to a three part event, finishing
with beautiful bride models.
Some of the most successful classes were the
360-degree or the “Conceive, Capture and Create
Classes. These not only educate, they emphasize
creativity and inspiration, as we take one idea from
start to finish. The one topic, one concept Photoshop
classes did well practicing these exercises. The
creative and unique classes with Bharat Mistry did
well. We will do more.
The Mentor walks create learning as we go. We get

pereuxphotography.ca

fresh air, exercise and hands-on. We will do more.
Many outings have been member created from

Essays Slideshows by some of our creative members,

Astrophotography to Orchid shows. The photo

followed by our Keynote speaker Ethan Meleg with

volunteer opportunities from the Town of Ajax (meet-

a humorous presentation “Confessions of a Crazed

up created by Michael Neilson) give members of all

Photographer”. Finishing with results from the Photo

skill level to practice and give back to the community.

Clinic III. Bring a photo friend.

APC members add to the history of Ajax.

This eventful year would not have happened without

To celebrate a year well done, APC is having its first

the amazing and talented board members that

end of season Gala and AGM at the St Francis Center.

volunteer so much of their personal time. Many

An incredible venue, a retrofitted church turned into

hours are spent organizing and implementing

a small modern theatre. Round tables will be set

creative ideas, presentations, competitions and

up, allowing us to enjoy the amazing catering by our

displays. Thank you to all members of the Executive

sponsor Debbie’s Café. It will be a licensed event.

team for all their years of devotion and time. We

The agenda will start with short announcements and

welcome the new and existing board members.

voting of the new board. We will feature Photo

Looking forward to 2016-2017.
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Photoshop Tips & Tricks
with Chris Noronha

To watermark or not to watermark?
Photographers have been debating this question since the dawn of the internet. In this day and age of the
copyright infringement and plagiarism, it can be a great feature to prevent unauthorized use of you images.
On the other hand, a watermark can become more of a distraction for the viewer. Whichever side of the
fence you sit on, creating a watermark in Photoshop is pretty easy, as we will learn in this tutorial below.
There are multiple ways of creating watermarks in Photoshop. Below, we will take a look at one of them.

Creating a Watermark
Brush in Photoshop
1. Create a new document

Open Photoshop and create a new document
(File > New). Ensure that your document is
large enough to fit your image. For this tutorial
I’ve made my document 800 x 800 pixels in
size. Make sure that you select ‘Transparent’ in
‘Background Contents’.
If your logo is not grayscale, go to Image >
Adjustments > Desaturate. Your goal is to
have your logo be black and the background
transparent. You can also use your signature
by scanning (using a scanner) a white piece of
paper with your signature on it.

3. Turn Your Text into a Brush

Now turn your text into a brush. To do this, first crop the image
to the size of your text:
Next, click on Edit > Define Brush Preset. In the dialog box that
pops up, give your watermark a unique name and hit ok.

2. Create Your Watermark Text

Use the Type tool to create your watermark
text. Make it as large as you want your final
watermark to be. If you have created a logo in
another program like Adobe Illustrator, you can
import it to your new document. Ensure the
background remains transparent.

Your Watermark is now a brush that you can add to your
image with the brush tool.
5
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Photoshop Tips & Tricks cont’d
4. Add the Watermark to the Image
Now open the image that needs to be
watermarked. For this example, we’ll use
this image:

You’ll now see your brush cursor change to your
watermark image.
Before you can create the watermark, you’ll have to
change the brush color. It’s best to use either black
or white, but for this example we will choose white.
Lowering the opacity to anywhere around 50% 25% in the brush attributes menu bar, will give you
that nice watermark effect.

Select the ‘Brush’ tool and from the brush presets
menu, scroll down and select the preset you just
created.

Tap the mouse over the image and congratulations,
you’ve successfully created a watermark!
As previously mentioned, this is one of the many
ways there are to create a watermark in Photoshop.
After you create your custom brush there is no need
to follow those steps again. Your custom brush
is saved in your Photoshop preferences and can
even be exported. The next time you want to add a
watermark simply grab your brush tool, select your
logo and click!
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What’s in Your Bag?
APC Member - Bryan
Vandenburg
For the most part my photography involves
shooting cricket for the International Cricket
Council. These games are played in Canada in
summer, Ft. Lauderdale, some Caribbean Islands
and Central and South America. As time permits I
enjoy shooting weddings, special events, nature,
landscapes, tennis, etc. for some R&R.
What’s in my Bag is determined by the assignment
and my method of transportation. Air travel, for
instance, is more restricted because of weight,
while ground transportation allows for back up
equipment to be included.
My bag would include items selected from “photo
1” and assembled for safe transportation in
secured cases “photo 2” and “photo 3”. Not shown
is my back-pack which would include a computer,
batteries and battery chargers, memory cards,
blank CDs, USB drives, power supplies for flashes,
passport & other travel documents, etc.

1

2

3
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APC Exhibits
& Competitions
with Bob Wilson
Exhibitions
Rouge Valley Hospital:
We have 2 new featured Photographers in the Rouge
Valley Hospital Exhibit. Frans Grootveld and Bob
Wilson. A new artisan agreement has been struck
with the Hospital Foundation and the prints are now
being offered for sale at a bundled price of $150.00.
40 % fo the sale goes to the Hospital Foundation as
a charitable donation and the photographer gets
a tax receipt for that amount. The remaining funds
are given to the maker minus the cost of the frame
and matte. We are always looking for “featured
photographers” and the process is very simple. The
maker prints their 6 images and the exhibit director
will collect them and have them mounted then
hung. The images are on display for 4 months and at
the end of that time we swap then for new images.
Please contact the Exhibit director if your interested
in being “Featured” at the Hospital.
Debbie’s Boutique Cafe, 94 Harwood Rd South:
Drop in to Debbie’s for some refreshments,
delectable food choices, and take a gander at
the excellent competition prints from the Ajax
Photography Club. Every 6 - 8 weeks the exhibit
gets refreshed with 10 new framed images from
our 2 competitions. We are currently displaying the
last of our Xmas Fun competition and the images
from our year end print competition will be the
next candidates. All images submitted to the 2
competitions get some “Hang Time” at Debbie’s
and the other various exhibits throughout the year.
( McLean Centre, Town Hall, and the Library Main
Branch for example.) APC holds regular Social
meetings/gatherings at Debbie’s about once per
month. Checkout the Meetup site for the next
gathering on July 8th.
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Competitions
Well we have had our last competition for the year and
it was very successful. We had 50 print entries from our
membership. The club paid for the cost of printing and I
mounted each print in identical portfolio mattes for judging
and display purposes. A closed judging session was held
in May, where 3 accredited judges from 3 sister clubs of
the GTCCC council, scored our member’s entries. A big
thank you to the judges from the Beaches Camera Club,
the Oshawa Camera Club, and the Don Mills Camera Club.
Also a big thank you to the Town of Ajax for the free use
of the ACC boardroom for the judging session ( special
thanks to Robert Gruber who arranged this resource
again this year). I wish to acknowledge the very valuable
contributions of the following APC members who helped
with the closed judging event. Without them, the process
would not have run so smoothly. Frans Grootveld, John
Stafford, Eileen Nixon, and Michael Nelson. All images
were displayed for member viewing at our May meeting
and will get a second showing at our final June AGM
meeting at the St Francis Centre. Congratulations to all of
the winners and a big thank you to all who submitted and
images. The judges were very willing to provide feedback
and it was shared with each photographer in a private
feedback document. All the feedback comments will be
summarized for educational purposes and be provided
to the membership as a learning tool. You can see all of
the entries on our APC meetup site under the Photos Link.
There is an album posted there with all of the submissions,
titled “APC 2016 Year End Competition Photos.”
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APC Exhibits & Competitions cont’d
GTCCC News
Fall Retreat: Sept 30 - Oct 2, 2106

Inter-Regional Competition: Nov 19, 2016

The Greater Toronto Council of Camera Clubs (of which
Ajax is a member ) will be holding a fall retreat on Sept
30 through Oct 2nd at the Geneva Park Conference
Centre, 6604 Rama Road, L3V 0S3 in the Orillia area,
right on the shores of Lake Couchiching. Details can be
viewed and reservations can be made by visiting the
GTCCC website at this link. http://www.gtccc.ca/ This
event is open to all GTCCC members and their guests.
There are accommodations available and all meals are
sit down dinning room style service. You can choose the
whole package or just about any combination of days
and events to meet your needs and schedules. There are
many activities and learning sessions planned to choose
from with high end key note speakers and educators.
Please see Bob Wilson your APC GTCCC rep if you have
any questions or contact him at r.003@sympatico.ca for
an e-mail response.

The GTCCC has an annual Inter-regional Competition
with a sister organization called the Niagara Frontier
and Region of Camera Clubs. The GTCCC takes winners
from the GTCCC interclub competion, held in March
of this year, and use these submissions to compete at
an international/regional level. This year the host is the
NFRCC. It will be held in the Niagara area on Saturday
the 19th of November. A great chance to see a live
judging and the work of photographers like yourself
from another region. Why not make it a weekend and
stay over in this beautiful part of the province. See the
GTCCC website http://www.gtccc.ca/ for all the details
or contact Bob Wilson at r.003 @sympatico.ca
Bob Wilson - Dir. Competitions & Exhibits

Debbie’s Boutique Cafe
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